TABLE OF CONTENTS

Welcome .................................................................................................................................................................................. 1
Features ..................................................................................................................................................................................... 1
More About the Fonts .......................................................................................................................................................... 2
Installation ............................................................................................................................................................................... 2
Overview ............................................................................................................................................................................... 5
The Essentials Library Window ............................................................................................................................................. 6
The Stitch Files Window .......................................................................................................................................................... 7
Embrilliance Design Pages .................................................................................................................................................... 7
Designs .................................................................................................................................................................................... 8
Embrilliance Objects ............................................................................................................................................................. 8
The Windows Docking Pane Interface .................................................................................................................................. 8
Files ........................................................................................................................................................................................... 9
Saving ....................................................................................................................................................................................... 9
Open vs. Merge ...................................................................................................................................................................... 9
The Main View .................................................................................................................................................................... 10
Zooming .................................................................................................................................................................................. 11
Magnify .................................................................................................................................................................................. 11
Measure Size and Counts (Stitches and Colors) .................................................................................................................. 12
Viewing in 3D ....................................................................................................................................................................... 12
Background and Grid .......................................................................................................................................................... 13
Hoops ....................................................................................................................................................................................... 14
Display Calibration .............................................................................................................................................................. 15
The Mouse Wheel ............................................................................................................................................................. 15
Ghost Mode .......................................................................................................................................................................... 16
Panning and Scrolling ........................................................................................................................................................ 16
Rules and Rulers ................................................................................................................................................................ 16
Selection .................................................................................................................................................................................. 17
Status Bar ............................................................................................................................................................................... 18
Navigation ............................................................................................................................................................................... 19
Objects View ........................................................................................................................................................................ 21
Selecting .................................................................................................................................................................................. 21
Locking ................................................................................................................................................................................... 23
Sequencing ........................................................................................................................................................................... 23
The Property Sheet ............................................................................................................................................................... 24
Color ....................................................................................................................................................................................... 25
Thread Brand and Color ....................................................................................................................................................... 26
Coloring Letters ................................................................................................................................................................. 30
Color Sorting .......................................................................................................................................................................... 30
Transform Controls ............................................................................................................................................................ 32
Mirror and Rotate .............................................................................................................................................................. 32
Centering In the Hoop ........................................................................................................................................................ 32
Fit to Hoop ........................................................................................................................................................................... 32
Remove Hidden Stitches .................................................................................................................................................... 33
Align and Distribute .......................................................................................................................................................... 33
Stitch Files ............................................................................................................................................................................. 35
Welcome

Hi, Welcome to Embrilliance Essentials!

Thanks for reading this User Guide! Since you’re here, let us tell you some things about this exciting program because Essentials represents a giant step forward in embroidery.

For starters, it is a small, yet feature packed program that is easy to install. It has versions for both Mac OSX and Windows. Windows versions install on XP, Vista and Windows 7 (including a separate Win 7 64-bit version.) It requires no hardware dongle and can be installed on multiple systems requiring only your personal serial number to be typed in for the program to run. Once you enter a serial number, you can register the program, which provides several benefits. One of those benefits is that if you ever lose your serial number, we can recover it for you.

This manual covers the features in the program Embrilliance Essentials. The idea behind Essentials is to include the features, which are essential for every embroiderer, yet not to overwhelm the user with unnecessary extras. It is designed to be simple and easy, yet powerful enough to accommodate the person who wants to do more than simply using existing designs.

Features

• 12 Fonts for multi-line text, monogramming and circle text.
• Sample designs, which are scalable and recalculate their stitches as you interactively transform them.
• Unlimited lines of letters or monograms and embroidery designs can be combined.
• You can mix and match fonts and sizes.
• Merge existing embroidery files into your design.
• Browse and Merge designs in folders and from inside .ZIP files.
• Resize existing embroidery files with stitch recalculation. You can resize embroidery designs up to 250% and down to 50%.
• Colorize any embroidery design. You can change the colors one at a time, or convert the entire design or any selected part of it to your preferred thread brand with just a few mouse clicks.
• Simulate the sewing of any design. The simulator can play in 3D, play forward and backward, and has variable speed. The simulator also has a slider so that you can manually scroll forward and backward through the design to any point without waiting. You can even insert a color stop in the sewing process.
• Convert any design from one format to any of the supported types, which include:
  • Read: ART, CND, CSD, DST, DSZ, EMD, EXP, EXP+, GNC, HUS, JAN, JEF, JEF+, PCM, PCS, PEC, PES, PHC, SEW, SHV, TAP, VIP, VP3, XXX, EMB.
  • Write: CSD, DST, DSZ, EXP, EXP+, HUS, JEF, PCS, PES (v1-9), PCM, SEW, SHV, TAP, VIP, VP3, XXX.
• Designer 1 Disk Utility for floppy and USB machines.
• Create a working file (.BE extension) to save your design as an editable and merge-able file. Your working file is saved for you automatically when you save a stitch file so you don’t have to ‘Save’ twice every time you make some changes—once for the stitch file and once for the working file.
• Embrilliance has an advanced program interface that’s super easy to use yet offers features normally reserved for very expensive programs.
• Real Scale zooming allows you to view your designs on screen at the actual size that they will stitch out.
• Navigation Window that provides instant control over the zoom and scroll in the program’s view.
• Sewing Order control allows you to re-sequence the designs to sew in the order you want them to sew.
• Color Sorting control to intelligently reduce the number of extra color changes.
Embrilliance

- Adjustable Mouse Wheel attribute for Zoom or Scroll.
- Simple centering in the hoop plus advanced alignment.
- Thread Palette creation and thread inventory system.
- Basting designs.
- Automatically check for updates.
- Digital Rights Management (DRM) so that you can preview embroidery designs before you purchase them!

More About the Fonts

These fonts give you enormous control over them. The specifics vary depending on which lettering style you're using, but in general, you can adjust the font, color, size, aspect, center, rotation, mirroring, slant, kerning, layout, stagger, sequence, envelope shape, stitching properties including density, underlay, underlay density and compensation (which can be used to increase boldness) for the design as a whole. And you can adjust the color, size, position, rotation, kerning, aspect and mirroring down to the individual letter. You can adjust the letter sequence for Monograms so that letters may overlap exactly how you want them. And if you do overlap your letters within a Monogram, the hidden stitches are automatically removed for you so that the design sews out nice and flat. For fast and easy Monogram setup, you have 14 Quick Styles to layout your design, including Vertical, Square, Oval and Diamond.

When sizing letters, your letters automatically switch to a fill-like satin stitch. This looks like a fill, but unlike a fill, the stitches maintain the beauty of the curved satin column. Another benefit of this is that fonts can be made far larger than ordinary embroidery fonts - some as tall as 8”.

To make the fonts even more versatile in size, automatic adjustments are made for you to help the letters sew smaller than they would in other programs. For instance, when you make the letters smaller, narrow satin stitching is automatically adjusted to keep long-enough stitches to actually sew. And although some small designs look good on screen, they won't embroider well. The fonts in the program protect your stitching automatically.

Multi-Line text offers line spacing, and in Circle Text, you can keep on typing, right into a spiral!

And Embrilliance can further be extended by adding font and design packs, now available from your dealer or online at http://www.Embrilliance.com.

Welcome to Embrilliance, and let the fun begin!

INSTALLATION

Installation of Embrilliance is easy. First install the disc or download the installer. If you have the disc, XP may automatically run it, but in later versions of Windows, Auto-Run has been turned off by Microsoft, so you’ll have to browse to it using Windows Explorer (a.k.a. “Computer”). Look for the program with “Setup” in the name and double click on it. This will start the installation. In Windows it looks like this:
Click 'Next,' then accept the license agreement by clicking the button, then click 'Next,'

Click 'Next.' You will usually want a desktop icon for ease of running the program. Click 'Next,'

You are now ready to begin installing. Click 'Install,'
You can run Embrilliance now, or you can just quit the setup by unchecking the Launch box.

You are finished installing!
OVERVIEW

Below is a picture of the Embrilliance window:

- As with most programs at the top of the window is the Main Menu, and below the Main Menu is the Main Toolbar. These two components are always available and handle the most significant commands of the program.
- The Tool Pane is a little different. It will display different contents, depending on what type of task you are performing. For instance, if you are running the Sewing Simulator, the controls for the simulator will appear in the Tool Pane.
- The Main view displays the current Design Page. A Design Page is a representation of a .BE file, which can contain multiple embroidery designs, lettering objects and frames.
- More than one Design Page can be open, and these are selectable by using the tabs above the Main View, just below the Tool Pane. As you save Design Pages, they will take the names you have given them. Until a page is saved, it will be called “Untitled...”
- The Status Bar provides relevant information about what is going on with the program’s current operation. For instance, if you are measuring items, the text in the bottom right corner of the Status Bar will update with the measurements created by that tool.
- The Navigation view provides an easy-to-use way to navigate around the current design page, and to control the zoom for it. This is especially useful when you have a lot of objects on a large design page and you want to go from one place to another without repeatedly zooming and scrolling.
- The Objects view displays Designs and Objects sequential order as they are opened or merged onto the design page. Each root (leftmost) item in the Objects view is a Design. A Design or object may be, for example, a lettering design, or perhaps a regular embroidery design.
- The Designs in the Objects view can have objects within them. To view those objects, click the ‘+’ which opens up the tree, thereby ‘disclosing’ the objects in the design. With a normal embroidery design merged into the page, you will be able to see individual colors within the design once you
Embrilliance

click the ‘+.’ Some designs, like lettering designs, may not disclose their individual objects because all editing is done via the Properties view.

• The Objects view can also be used to select designs and objects, which is useful when objects within a design are grouped, such as with regularly merged embroidery designs.

• The Properties view displays information and controls for the currently selected objects and designs. For example, if a single-color design such as lettering is selected, you will see in the ‘Color’ property page only the single color for the lettering. If no design or object is selected, the Color property page is shown and the colors for the entire design page are shown.

The Essentials Library Window

The Library window is used to merge designs into the current Design Page.

![Library window]

The Interactive/Moddie Selection Window is used to merge Embrilliance designs into the current Design Page.

Clicking on a collection icon on the right will result in the designs from that collection to appear on the left. To import a design, select it and click OK. You can also double-click on a design to import it and close the window.

**Note:** In most cases, the merged library design will be placed on the screen to fit the hoop, whether the hoop is displayed or not. If you have a very small hoop selected, the library design may be too complex to be shrunk to fit the hoop. Library designs can be resized to the desired proportions after placement.

**Note 2:** Whenever you add any design—whether Library, Lettering, or any design file—it will be initially placed in the center of the hoop. If for some reason you don’t see a newly added design, zoom out so that you can see the center of the hoop.
The Stitch Files Window

The Merge Files Window is used to merge existing embroidery files into the current Design Page.

The Browse view on the left side is called a ‘Tree’ control, and it has a 'Root' level, which is left-most and ‘branches’ which you can open and close using the ‘+’ and ‘-’. You will also see individual .ZIP files as branches, so you can import designs directly from within those as well.

On the toolbar, there are controls for thumbnail size and 3D display. The ‘Close’ button will close the window without importing anything. The “Sel. All” button selects all the designs in the view on the right.

To bring designs in, click ‘Import’.

As with most views like it in Windows, the thumbnail view on the right allows single design selection, by clicking on an item. But also you can select a range of designs by first selecting a design then holding the shift key down and clicking another design. Additionally, you can use the control key to click on different designs that are not next to each other, and that will select those too. This is called a disjointed selection.

You can also double-click on a design to import it and close the window.

Embrilliance Design Pages

A Design Page is where designs and lettering can come together to form a composition or a scene. That page is also represented as a single embroidery (or working) file. For example, you may have merged multiple embroidery designs, added a couple lettering designs, and then surrounded them with a Library frame. All those individual designs exist on the Design Page. That scene can be saved as an embroidery file for use in your machine, and it can also be saved as a ‘Working File’ (extension .BE), which allows for editing later. (Suppose you miss-typed some lettering.)

As Design Pages are opened or saved, their name will appear in the Tabs above the Main View. You can switch between Design Pages using the Tab View. This is handy for clipboard operations such as doing a copy and paste between Design Pages.
**Embrilliance**

**Designs**

Each Design on a Design Page is one of the three types, ‘Embroidery Design,’ ‘Lettering Design’ and ‘Library Design.’ These design types work together to build useful embroidery compositions. The designs are visible on the Design Page in the Main View, and the sequence of the designs is visible in the Objects View.

Designs are collections of objects. For example, a merged embroidery design is a collection of color objects, each of which contains stitches for a single color in the design.

Designs may be ‘Grouped’ which allows you, the user, to select and move the design around in the Main View as a single design. By default, when you merge an embroidery design into the page, it comes in as grouped. If you want to change one or more colors (or objects) in the design, you have some options:

- Ungroup the design, which makes each object selectable in the Main View.
- Select the object or objects in the Objects View.

Designs as they appear in the Main View may be ‘Locked’ which prevents inadvertent moving or editing. The lock may also be used to hide the design(s). The state of the Lock is set using the Objects View toolbar.

**Embrilliance Objects**

Each Design on the design page can contain one or more objects, each of which contains colors, stitches and other information. The only objects you will see are individual color objects within a merged embroidery design. Each object can be moved, edited, deleted, etc.

**The Windows Docking Pane Interface**

This interface can be configured and the configuration is persistent, i.e. it is remembered between program invocations. The controls for this interface consist of a Pin, a Close Box and a Tab. The Pin and Tab are related. When the Pin is “unpinned” the window slides into the main window frame and presents a Tab with the window name. When the Pin is “pinned” the window stays open and the Tab goes away.

In the unpinned configuration, hovering the cursor over the Tab reveals the window. When the cursor is moved out of the window it slides back into its unpinned position.

The Close Box dismisses the window altogether. To restore a dismissed window you must use the View Menu->Toolbars and Windows item to restore the dismissed window.
Embrilliance uses a few different file types, each having its own file extension. For example ‘.BE’ is a working file. This file type contains all the Designs and Objects representing a single Design Page. These designs and objects can be edited, as they have not been forced to become a simple set of stitches, which is what most machine-embroiderable files are.

Licensed files, such as fonts will have .BF and .LF files. These are installed by the installer for our collections. You cannot edit or use these files as a user. The program loads them automatically as needed.

Stitch files, which in the commercial embroidery trade are called ‘expanded’ files such as .PES or .DST are simply collections of stitches, and if you are lucky, colors.

When you save a Design Page it will ask you to choose which Stitch File type you want to use. For example a Baby Lock / Brother embroidery machine owner will choose .PES as the stitch file type. In addition, the program will also silently save a working file (.BE) thus saving you the extra step of saving it separately. As mentioned earlier, the working file allows you to edit your designs including text. If you want to save individual files (not both stitch and working) you have all the options on the File menu.

Files can be ‘opened’ which starts a new Design Page in the Main View so that you can see the open file. Use Open for .BE files.

If you already have a Design Page open, you can ‘merge’ files, which adds the contents of the files to whatever you have on your page currently. To merge a file click on the Merge icon on the Toolbar or go to File/Merge Stitch file or Merge Working file.
THE MAIN VIEW

Design pages are displayed in the Main View of the program. There can be multiple design pages open at any given time. For each page in use, a Tab control is displayed at the top of the Design page. Additional Design pages are added by clicking the New button on the Main tool bar, by pressing Ctrl-N by choosing New Page from the File menu or choosing New from the Window menu:

A design page is activated by clicking its Tab control. Or you can select it from the list in the Window menu.

The Tab control will display the name of the file associated with the page once it has been saved, otherwise it is named “untitled x” where x is a running number.

The Main View has a background, a hoop, and rulers along the side and, naturally, the designs you have placed in the Design Page.
Zooming

Zooming is handy for edits, and this makes the process of zooming more convenient. Also, one of the options in the program is to be able to use a mouse wheel to scroll the design page up and down. If you have this mode on, the zoom slider is another useful tool. Just a reminder, there are also keyboard shortcuts for zooming: ‘z’ zooms in, and ‘Z’ (shift-z) zooms out.

Zooming can also be accomplished with the Zoom Menu and Toolbar controls.

- ‘All’ zooms to all objects on the design page.
- ‘Selected’ zooms to selected objects on the page.
- From the Zoom menu specify what should be zoomed: the Hoop, All elements or the Selected element or choose the amount of zoom.

Tip: Memorize the keyboard shortcuts for the Zooming and Panning; using them can speed your designing!

- Use the Zoom slider to zoom on the Main view. Up zooms in, down zooms out.
  There are zooming keyboard shortcuts:
  - ‘z’ to zoom in
  - ‘Z’ to zoom out.
  - 0 = Fit Hoop
  - ‘A’ to zoom all
  - ‘S’ to zoom selected
  - 1 - 9 will zoom to 100%-900% of real-world scale.

Magnify

The Magnifier on the Main toolbar will let you change the zoom in three ways after you click on it:

- Left-click to zoom in
- Right-click to zoom out
- Drag a rectangle to zoom on just that area. (This will also cancel the tool.)

Note: The Overview or Navigation window can alter the zoom too, and we’ll cover that in its own chapter.
Measure Size and Counts (Stitches and Colors)

The Measure button on the Main toolbar will set the program in a mode, which allows you to measure items in the Main View.

As you drag the cursor, you are measuring the distance you've dragged. This distance is displayed on the status bar:

13.8mm x 0.2mm, len: 13.8mm, -179°

To cancel measuring, click again on the Measure button in the toolbar, or click the Selection Tool (arrow) in the toolbar. Items that are selected also have their size, stitch count and color count shown in the status bar. If nothing is selected, then the size and counts for the entire Design Page will be shown.

Viewing in 3D

The default setting for the Main View is to display stitches in a realistic 3D, which lets you easily see where the needles will penetrate the fabric. This can be turned off using the ‘3D’ button on the main toolbar.
**Background and Grid**

You can alter the background of the Main View. Click the Preferences button on the Main toolbar. This will bring up the Program Preferences window, which allows you to set many program and Design Page options. Click on the Grid Settings to adjust them.

![Program Preferences Window]

To change the background color, click the Color button, which will display a standard color picker:

![Color Picker]

*You can even create your own colors and add them to the custom colors section. Select a Custom color and click OK to set the new color.*

**Adjustments:**

- The Grid is adjustable too. You can alter the display of gridlines by choosing between lines and dots. You can also set the spacing of the grid, and that can be set separately for both metric and inch settings.
- The arrow buttons, labeled “>>” and “<<,” will copy the settings from inches to metric and vice versa. Thus, you can set up a grid that has metric spacing for machine/hoop accuracy, but can display information to you in inches.
- Snap-to-Grid will help align objects to the grids as you move them in the Main View. As you move in one direction (up, down, left, right) the edge of whatever you are moving will ‘stick’ like a magnet to the grid as you approach a grid line in that direction. If you want to overcome the snap-to-grid, you can pass the grid and then come back in the reverse direction. (Which means the opposite edge will want to snap to some other grid.)
- Grids do not force you to stick to them when Snap-to-Grid is on. Rather, it merely enables the snap as you get close, which may help with precision alignment as you move things around.
Embrilliance

• Using the menu or the Grid button on the toolbar, you can turn the Main View display of the grid on and off.

Hoops

The hoop that you will view in the Main View is chosen for the Design Page using the Preferences Window also.

Left: Hoop selection. Right: This is what a hoop looks like in the Main View.

Using this window you can select different hoops, the selected hoop to be shown rotated 90°, add new hoops of your own creation or edit the selected hoop. The ‘Defaults’ button reloads the hoops that are installed with the program. This is useful if you update the program or have previously deleted some default hoops.

Note that when you create a new hoop or modify an existing hoop, that you are really defining the sewing area, or what is known as the sewing field, not the physical dimensions of the hoop. You must know your machine’s embroidery field as you cannot create a hoop that is larger than what your embroidery machine can sew.

Note: When you create a new hoop, it will become the selected hoop.

Trouble shooting: “I can’t see the hoop and it’s checked in View > Draw Hoop.”

There are 3 primary reasons this can occur:

• A very large hoop may be outside the visible work area
• A very small hoop may be completely covered by the design.
• Designs are outside the range of the hoop and your view is zoomed in, causing the hoop to be outside the currently visible area

Check the status bar at the bottom of the window for hoop information, which displays the selected hoop whether it is visible or not. Zoom out to find the hoop (if it isn’t buried under your design).
**Display Calibration**

The Main View is calibrated to a real-world scale for precise display of designs. Use the Preferences Window to calibrate your display for real-world size:

Hold a ruler up to your screen and adjust the slider until the measurement in the program matches your real-world ruler. This will help you better estimate real design size while editing designs.

**The Mouse Wheel**

The Mouse Wheel can zoom the Main View in and out. It can also be used to scroll the page up and down. We recommend that you use the setting that allows for zooming as this is more useful to most users.
**Embrialliance**

**Ghost Mode**

Ghost Mode is an option relating to how the Main View displays objects when not selected. The idea for Ghost Mode is to make it more obvious which objects are selected by fading out those items that are not selected.

Left: **Ghost Mode on.**

Right: **Ghost Mode off.**

*The intensity of the Ghost Mode can be altered with the Preferences.*

**Panning and Scrolling**

The scroll bars at the right and bottom of the Main View can be used to scroll the view around, which is very useful when you are zoomed in.

There is also a mode that allows you to ‘Pan’ the design, which works like a scroll, but where you move the view by dragging the mouse. Hold the space bar down and drag the mouse to pan the view.

**Auto-Scroll**

As you drag on the main view, you may come near the edge of the page. This will cause the page to scroll thus enabling you to drag into a position that’s not currently in view.

**Rules and Rulers**

Rules exist along the top and left sides of the main view.

They indicate location from the center of the hoop. You can switch the rulers between metric and inches using the radio buttons on the Tool pane or by double-clicking in the size window in the status bar.

You can also drag rules onto the Main view. Move the mouse over one of the rulers and drag down into the view. If you later want to move the rules, you can drag them. If you want to remove them, you can drag them one at a time back onto the ruler.
Selection

One of the most common tasks in the Main view is to select items. Using the Selection Tool (Arrow button on the main toolbar) you can select and move items in the design page. Select items by clicking on them. This will place ‘handles’ and a dotted line around the selected items.

You can also see that items are selected by looking in the Objects view. Another way to select items in the Main view is to drag a rectangle around those items. Anything completely in the rectangle will be selected. However, if an object is grouped with something outside the rectangle, it will not be selected.
Embrilliance

Status Bar

The status bar is located at the bottom of the program window. Size, stitch count and color count information appear on the right side of the status bar. If you have no design selected, then the display will contain information about the entire design page. If you have something selected, then the information contains the word, ‘Selected’ and represents only those selected items.

You can double-click on the size information in the status bar to quickly switch between metric and inches on the design page and status bar.

The status bar also has a line of text on the left that can provide additional information about an on-screen control. Hover the mouse over a control, specifically a toolbar button, and the status bar may provide additional clarification of what the button does.
The Navigation H.U.D. (Heads Up Display) is an ingenious device that keeps navigation tools readily available, yet tucked away, for easy access to the entire working area on your Design Page. To access the Navigation H.U.D. (aka: Nav H.U.D.), click the Compass Rose icon at the top of the zoom slider in the upper right hand area of the main view.

The Nav H.U.D. is especially useful when working on large designs and/or a small monitor. It quickly gives you a bird’s eye view of your work area as well as a nice “you are here” indicator. In the following image, the area around his eyes will be centered on the screen.

As you move the cursor, the ‘+’ indicates the area of focus. The panel lets you pan around the design page. The benefit is that you can make edits to different design sections while you are still zoomed in to a comfortable level.

The Nav H.U.D works in conjunction with the Pan Tool, which is accessible by holding down the spacebar.

*Hold the spacebar and drag with this cursor to pan.*

Whereas the Pan Tool is useful for moving around the area you are currently working in, the Nav H.U.D. makes it easy to scroll across the entire page to a specific place in one easy step.

The chosen hoop is shown in the Nav H.U.D. whether that hoop is visible or not. This is because the size of your workspace is related to the size of that hoop. The selected hoop is a visual reference only and
Embrilliance

does not prevent you from designing or saving projects larger than the selected hoop or, for that matter, larger than your machine can sew.

Therefore if you have a small hoop selected and a design that well exceeds the hoop boundaries, it is possible that you won’t be able to navigate to the outer reaches of your design. The solution is to select a larger hoop from the Environment > Hoops option in the Program Preferences panel.

![Same design with the hoop set to 60mm x 40mm with the cursor shown at the upper left limit. Parts of this design are inaccessible.](image)

Normally, once you've panned or zoomed in the Nav H.U.D. the panel will automatically close when you release the mouse. If you’d like to leave the Nav H.U.D. open while you move to several locations, click the ‘Pin’ button just to the left of the close box. Once pinned, the panel will stay open until you click out of it, or click the ‘Close’ button on the top, right in the H.U.D.

![Unpinned (default setting) vs Pinned](image)

Notice on the top of the Nav H.U.D. are three small buttons labeled ‘A,’ ‘S,’ and ‘H.’ These buttons correspond to preset zoom settings of ‘All,’ ‘Selected,’ and ‘Hoop,’ whose keyboard shortcuts are respectively ‘A,’ ‘S,’ and ‘0.’

Just below the compass rose icon is a zoom slider. Slide up to zoom in; down to zoom out. Click on the ‘+’ and ‘-’ buttons to zoom in and out also. If you’ve ever used an online map, this zoom slider control should feel familiar. The slider control also responds to numeric key entry. For example, pressing 5 will move the slider control to 500%.
The Objects view shows the designs that have been opened or merged onto the Design Page and objects within those designs.

Notice that the designs are numbered in the Objects view. The designs or objects are numbered in the order that they have been opened or merged onto the design page. In the illustration above lettering was opened onto the Design Page first. So, it has been numbered 1. The following merged design is number 2 in the sequence. When re-sequencing objects the numbers will change accordingly.

Using the Objects view designs may be selected, sequenced and deleted. The Objects view can display individual objects within designs where allowed. Stitch files (merged embroidery designs) are one example of a Design Type that allows the display of individual objects within the design. Clicking on the ‘+’ at the left of the design will expand that design in the Objects view. Under that design will then appear the individual objects.

Using the Objects view, objects may be selected, re-sequenced or deleted.

Auto-Scroll

As you drag on the Objects view, you may come near the top or bottom edge. This will cause the view to scroll thus enabling you to drag into a position that’s not currently in view.

Selecting

Using the Objects view you can select any number of Designs or Objects, regardless of whether or not they are locked, hidden or grouped. This allows for editing of objects or designs without un-grouping. For example, the following design is all grouped so that it can be moved around the page as a single design. However, you may want to select just the second color to change it, re-sequence it or even delete it.

The toolbar on the Objects view also has selection options including ‘Select All’ which is the first button on the left. If the Main view is active you can also type Ctrl-A to select all or you can use the Edit menu for this option too.

Reverse Selection
Embrilliance

The second button will reverse the current selection. This means that whatever you have selected will no longer be selected, but everything else will become selected. This is useful when you want to delete everything except for a single design element.
**Range Selection**
Using the Objects view you can select multiple designs or objects. If a single object is selected, you can use the shift key while clicking a second object and this will select a range of objects: Everything in between the two will be selected.

**Disjointed Selection**
If you use the Ctrl key while clicking on objects, you can singly select designs or objects. To de-select an object that’s already selected, Ctrl-click on it. This will reverse its selected state.

**Graphical Selection**
You can also drag a rectangle around objects in the Objects view to select whatever is in the rectangle.

**Note:** Dragging enables Auto-Scroll, and your view will move allowing you to select items that weren’t initially visible.

**Selecting by Color**
If you want to select all objects of a given color, select one of the objects as described above. Then use menu option, Edit->Select by Color. This will find and select all the objects on the page which have those same colors in them. This is a handy feature to change the color of several things at once.

**Locking**
If you want to prevent designs or objects from being selectable in the Main View, you can ‘Lock’ them. Locking an object does not affect its grouping; it only prevents it from being clicked on. The second button, a white lock with an ‘X’ on it, will not only lock the design or object, but will prevent it from being displayed in the Main View.

To unlock something, click the third lock, which appears as an open lock icon.

**Note:** Locking does not prevent you from selecting it in the Object tree, where it can be resequenced, copied, or deleted.

**Sequencing**

The sequence of objects and designs can be changed using the Objects view. One way is to right-click on a selected item which will cause a pop-up menu to be displayed. That menu has options to move items earlier or later in the sequence.

You can also drag and drop items in the tree to re-sequence them. Dropping an item (let’s call it ‘B’) on another (called ‘A’) will place that dropped ‘B’ item right after ‘A’ in the sequence. If you drag an object onto the design icon, then that drop will be placed at the head of the design.

You can also re-sequence selected designs and objects using the ‘Sequence Objects’ command on the Edit menu.
When you have design or object items selected, there may be properties that you can adjust. The Property Sheet contains individual ‘Property Pages’ that let you adjust the selected items. The pages are displayed as tabs. Click on the tab to work with the design or object items that are selected.

If nothing is selected, the Property Sheet will display the Color property page, which in turn will show every color in the Design Page. This is a convenience that allows you to change colors on the page.

**Note:** Sometimes, users will confuse the Colors property tab with the Object View. You cannot select anything using the Colors property page. This page merely reflects what is selected and lets you change the colors on display.

The individual tabbed pages that you see will depend on the designs and objects that you have selected, and we’ll cover those individual controls in the respective sections for the design types; Lettering, Embroidery and Library designs.
Color

Color is unexpectedly influential. We may be initially attracted or repelled by an item or design simply because of its color. The ability to view designs in realistic thread colors is an asset to the embroiderer.

You may want to recolor a design to better suit your tastes, to coordinate with the threads you have in your stash, or to color a design that you've converted from a format that doesn’t hold color settings, such as .DST.

When you merge a Library design, create a lettering design, or merge a stitch file, the objects come in with the colors and the thread brand that the designer has assigned—even if you have another brand specified as preferred (more on that in a bit).

If the merged stitch file is a .DST file or other format that does hold set colors, then threads cannot be matched to any thread brand and will simply be a list of generically named colors.

Tip: If you'd like to get an idea of how your design looks on a particular color, you can change the background of your main window in Environment -> Grid Settings in the Program Preferences.

Changing colors is done via the Color tab on the Property Sheet, which is the lower panel on the right hand side of your screen. The color tab displays the thread sequence of the design. Selecting a color swatch on the tab doesn’t select anything in the design; it simply allows you to select and apply a different color from any of the thread brands loaded into the program.

When first getting acquainted with Embrilliance, it may be confusing to see what looks like two color lists. The top list shows a tree-like structure of all the various objects in the current main window. This includes Library designs, letters, and any merged files. In the sample shown below, a single design has been merged and the design has been opened in the objects panel so that all the various objects can be viewed.

Because this is a stitch file, each object is all the stitches that are contained within a given color. In this instance, when you compare the object list next to the color list, you'll see that they match. For example, object 1:6 corresponds to color six in the following samples.
The color tab will show the colors of the currently selected object(s). If nothing is selected, the list will show all the colors on the current design page. You can select areas of your design by clicking them in the object list. You can select more than one area by holding down the Ctrl Key.

The colors list only shows the colors of the selected items.

Thread Brand and Color

There are three buttons across the top of the Color properties tab:

- **Thread**... Select a thread library to use and set a preferred thread brand
- **1 Color**... Make the design monochromatic (one color)
- **Preferred** Change the colors to the closest match in your preferred thread brand

To change a thread color, simply click on the color swatch that you wish to change on the Color tab. The Thread palette will open up with the color selected in the original thread brand specified by the designer. You can select a different thread line from the drop down menu and the program will find the closest match in that chosen thread line.
Embrilliance includes a wide range of popular thread brands and lines.

Note: In the case of a DST, TAP or EXP file, the Color tab displays a list of generic color names. This is because these formats have no color information in them. Using Embrilliance you can color these designs, and when you save the working file, the colors will be saved there.

Similarly, PCS, PCM and HUS formats have limited color palettes. Again, saving the working file will preserve your colorization, and you can print colorized design templates and color information. This is especially handy for commercial embroiderers.

Clicking one of these color swatches will open the thread brand that you have set as preferred (Madeira Thread Chest is the default). To change the color, navigate to the desired color and click OK.

.DST file shown with generic colors and the thread palette displayed.

Some thread lines only have thread numbers, while others have numbers and color names. You can search either line by thread number but you can only search by name if the threads have color names. Type in the color or thread number in the search box and click ‘Go.’ Or, you can simply scroll through the list and pick one that appeals to you. Once the color is selected, click OK to apply it and close the Thread palette.
Threads can be searched by number or name.
The ‘Thread...’ button allows you to change thread brands or to set a preferred brand by choosing a thread brand from the pop down list. Once a preferred brand is selected, you can easily change all the colors in any design to your preferred brand by clicking, “Use this as my preferred brand.”

A thread brand can be selected on a per-design basis or can be made preferred.

**Note:** Be advised that while this may be convenient for you, if your design has carefully chosen and blended colors, converting brands may cause a less than desirable result—especially if a “close match” does not exist in the new brand.

*Left: Original Hemingworth colors. Right: Shown using Brother Flesh Tones.*

The color list does not name the areas that are colored. For example, suppose you want to change the pink shorts on the mouse design to blue. An easy way to do this is to find the area in the Object panel and select it. The color is now isolated in the Color panel and you can easily click it and select a blue.
Embrilliance

Coloring Letters

Coloring Letters works a bit differently. To color individual letters, click on the center of the letter to select it. Then, as before, click the color swatch to select a new thread color.

Color Sorting

The “Happy Birthday” design has 6 unique colors but 13 color stops. To make it more efficient for sewing, you might like to optimize the sewing order to reduce extra color changes. Because letters added together are considered one object, you can’t selectively rearrange them in the object tree. Fortunately, there is easier method accomplished via Color Sort, which can be accessed on the toolbar just to the right of the Undo and Redo buttons.

Clicking the Color Sort button displays the following dialog window:
Notice our design has been reduced by 5 colors.

Click ‘Save It...’ to save the color sorted file as a stitch file. If you don’t change the name, the program will append “_sorted” to the end of the current file name. Your original working file (.BE file) is preserved and not changed.

Color sorting can be useful in designs like this or designs that have poor sequencing. Color sorting in this program is intelligent, meaning it doesn’t indiscriminately combine all like colors together. It looks for layering and knows that some colors simply must be repeated.

**Note:** Do use caution when color sorting. Some designers have intentionally added extra color changes either for design flexibility or to optimize registration. For this reason, always Color Sort a copy of a design!
Sizing and positioning of design elements can also be accomplished using the Size and Position controls panel located on the Tool pane. The first control on this panel sets the unit of measure for the design page. The choices are millimeters and inches.

The width and height of a selected design element can be precisely set by entering the desired value in the width and height text box and pressing the enter key. If an exact size is not known, the element can be sized as a percentage of its original size by entering a percent value in the percent text box and pressing the enter key.

These controls are also updated as a design element is moved or re-sized using its handles. The element is scaled proportionally if the Scale Proportionally control is locked, otherwise height and width changes are applied individually.

Locked—Scale Proportionally

Unlocked—Scale Height and Width Individually

Note: If you have sized an element and want to return to its original size, simply lock the Scale Proportionally control and enter a value of 100 in either of the percentage fields. Embrilliance will remember the original size even when you reopen the design at a future date.

Mirror and Rotate

The next four controls mirror and rotate selected elements. Mirroring is about the horizontal or vertical axes. Rotation is clockwise or counter clockwise in 90 degree increments with the pivot point in the center of the selection. Alternatively, you can enter a specific value for the degree of rotation. Enter a positive value to rotate counter-clockwise and a negative value to rotate clockwise.

Centering In the Hoop

Centering in the Hoop can be accomplished by this button, although it is not necessary because, as a rule, designs are centered when stitch files are saved. This is also available from the Utility menu.

Fit to Hoop
Design elements can be scaled up to the design page by selecting them and clicking the Fit Hoop tool. This will recalculate stitches wherever possible. There are limits, though, such as with regular embroidery designs, which can only be sized up to 250%. This button will scale your design as large as it can go, up to the built-in limits.

**Remove Hidden Stitches**

When designs are overlapped, there may be stitches that are hidden, which you would like to have removed. This process is automatically done when you save a file (controllable by preferences) but you may want to preview the results before saving. The Remove Hidden Stitches will run the process on those stitches so that you can evaluate the result. The result is temporary, however, so if you change anything on the design page, the stitches will return. This happens because changing a design will almost always regenerate its stitches.

**Align and Distribute**

Alignment of multiple items can be set using the Align button, which will open the Align and Distribute window. Alignment will place the edges or centers of designs all on one line.

If you have two or more items selected, you can align them. For example, these items are Aligned Left:
Embrilliance

Distribution is different from alignment. Distribution places designs equidistant across a distance. This is useful if you want to make regular patterns, such as a tiled design. If you would like items distributed across an area, move the first and last items to the outside areas that you want to fill. In this example, the (top, left) ‘A’ and the (bottom, right) ‘A’ make the design size. But notice how the ‘A’ designs between those are not placed regularly? Distribute will make those ‘A’s into an orderly row:

Using ‘Center’ distribution will distribute these letters evenly, based on each letter’s center.

If you choose a different edge to distribute with, for instance, Left, then the distribution will be made using the left edges of all the designs. This can be useful to create a geometric composition with different sized designs.
Clicking the Merge Stitch File tool found on the Design Toolbar or selecting Merge from the File menu will display the Open Design Files dialog. Here you browse for embroidery designs to add to the Design Page.

The Merge Design view allows you to browse thumbnails of your files and select one or more files in import.

- The Size control of this dialog determines the preview size of the design thumbnails (the design does not have to be selected for the determined size). The 3D control shows the preview in 3D, i.e. it shows simulated stitches.
- Click the Import control to bring the selected design(s) into the Design Page. The imported design will be centered on the Design Page.

Merged Stitch File behind Monogram
Embrilliance

Size and Move

The lettering, the Library designs and the merged stitch files can all be sized and moved.
Existing embroidery files can be resized with stitch recalculation. You can resize embroidery up to 250% and down to 50%. If you want to resize an existing design without stitch recalculation, hold down the Ctrl key while dragging the handle.

- Click and drag on a black handle to resize the design.
- Click and drag the round blue handle to rotate the element.

Click and drag anywhere on a design element to move it. As the design is moved off the page, in any direction, the page will automatically scroll if the cursor is in the ruler area of the page. For finer movements (1mm at a click), the selected design element(s) can be nudged using the keyboard arrow keys. To move objects one stitch point at a time (.1mm); hold down the control key while pressing an arrow key.

When resizing, understand that not every design can be recalculated perfectly. Some designs such as cross-stitch and freestanding lace are not going to resize correctly. Another consideration is the level of detail. Highly detailed designs radically reduced will lose clarity and crispness as the details become squished together.

**Note:** This is one major benefit of the Library designs; they can usually scale and calculate their stitches for you.

Deleting Stitches by Deleting a Color

Often you will want to delete a section of stitches from a design that has been merged. When those stitches are all grouped as one color this is easily accomplished using the Object View. Open the design using the ‘+’ in the tree. Next, select the color you want to delete. Next, choose ‘Delete’ from the Edit menu or use the ‘Delete’ key on your keyboard.

Below, the first color of the design is selected. Simply press ‘Delete’ on your keyboard to remove the first color along with the stitches associated with it.

**Note:** Another way to delete is to use the menu, Edit->Delete.
Left: Color is selected. Right: Color has been deleted.
OTHER PREFERENCES

There are a number of preferences for the program and design page that can be adjusted. Click on the Preferences button to reveal these controls.

Sizing of Design Files (Advanced)

When you resize a regular stitch file, the density would normally get more or less dense, but Embrilliance will recalculate the stitches for you automatically.

That recalculation process is complex and difficult, so there are some settings you can adjust to achieve optimal results. The sensitivity control is used to control how well the program discovers fills and satin stitches. If you have a design which has a lot of manually created stitch effects, then you may want the sensitivity higher, whereas normal designs that are digitized with objects like fills probably don't need so much sensitivity, especially if there is blending going on.

- Gap Reduction is a function within the software that helps adjacent areas lessen gaps that might be exposed or widen during increases in size.
- The stitch length filters are used to prevent loopy stitches on the fabric from stitch elongation, and in the other direction, small stitches from gathering on the fabric making too many perforations or simply bunching up the fabric.

The settings are broken out by stitch type because the handling of satin stitches is special and you may want to achieve a split-satin look at a certain size.
In the Preference window, under Environment, you can choose a hoop. Hoops are displayed in a sorted list, organized by embroidery file format. Most embroidery hoops are made using the metric system, so the sizes for the hoops are displayed according to the way the manufacturer sells the hoop.

There are many hoops that are built into the program, and you can add your own. As the program updates over time, or if you have edited a hoop, you can use the “Defaults” button to restore the program to the hoops provided. The “Default” button will not, however, remove any hoops you’ve added yourself.

Many times you will want to sew a design sideways in the hoop. But rather than laying out your design sideways, it might be convenient to have the hoop displayed as rotated. Checking the “Rotate 90” button accomplishes this.

If you have added a hoop, or if you decide to have the program display only the hoops that you own, you can delete hoops from the list, using the “Delete” button.

You can create hoops and edit hoops too.

The width and height fields are self-explanatory, and you can name your hoop as desired. Hoop names should be unique.

**Note:** Do not create a hoop that is bigger than the sewing field of your embroidery machine.
Embrilliance

File Conversion

Designs can be saved into many different formats. The Conversion Preference allows you to adjust some parameters when you save in those different formats.

The file format itself may have inherent limitations on the number of colors or stitches, such as the 16 color limit in .PCS. But there are also machine limitations too. Older machines that use the .PES format had limits of 100 colors, whereas the newer ones can go to 127. To help you save files correctly for your machine, there are options for some formats, such as .PES.

PES Files have to support two distinct machine types, and also have different data for the support of card reader/writers that many .PES machines required. Let’s look at the .PES options more closely.

“Use version 5 and later for real threads.” This setting exists because the version 5 of the Palette/PE-Design software, which invented the .PES file, added support for real thread colors. This was a wonderful addition for this format. However, if you own an earlier version of the software, and you want to use files created in Embrilliance, then you need to leave this set to “Force version 1.” The reason is simple: The old software simply cannot open those version 5 files.

The machine specific settings are for machines like the Ellegante, which takes the 180 x 300 hoop (while other machines may not be able to accept this hoop, so why write a file for it.) Or the multi-needle machines, which have their embroidery field rotated to a landscape position. So a 200x300 or a 300x200 field, while technically the same size, have different rotational parameters.

Certainly you know if you have a multi-position machine, or require the use of older software to write your card. If not, or if you are distributing these designs, please just leave the settings as-is. The program actually finds a Lowest Common Denominator in the format that it will output, making the file available to the widest range of users.

DST and EXP Files have a different type of information contained in them where it pertains to jump stitches. Rather, those formats have to have some number of “Jump” commands in a row before they will cycle their thread trimmer. When making a DST file, and converting from something else, these jump commands need to be translated. As machines differ in setup for the number of commands needed to cycle the trimmers, we offer this setting in the conversion preferences.
Preferences

Preferred Stitch Format

Most embroiderers have one machine or other that they use most for embroidery and that machine has a format that it uses. To save time, the format that you choose here will automatically be selected during the save.

![Program Preferences](image)

Set this as your preferred stitch format, which gets saved along with a warning file when you choose Save from the menu.

Note: Even though you have set a preferred format, you can still choose File > Save Stitch File As if you need to occasionally save in a different format. After selecting a new format in the Save As dialog box, that format will “stick,” over riding the Preferred Stitch Format until you either reselect the preferred one or a new one.

Note about SHV: Setting the preferred format to SHV does not create the file structure your machine may expect to see. To create a proper Designer 1 diskette or stick, please read the next section.

Creating a Designer 1 Disk or Stick

If you have a Husqvarna Viking Designer machine that uses either a USB stitch or a 3.5” diskette, you can create the proper files and file structure via Utility -> Designer 1 Disk Utility.

When the Designer 1 Disk Utility window opens, choose whether you want to write to a diskette or a stick. Next, choose which menu you on which you want to store the designs. Designs are imported to only one menu at a time.

![Designer 1 Disk Utility](image)

Click the ‘Get Design...’ button and navigate to the desired designs. You’ll see the now familiar ‘Get Designs’ window where you can select individual designs or the entire folder to import.
Embrilliance

**Note:** Each menu can store up to 36 designs. If you select more than that to import, only the first 36 will be imported.

![Image of Embrilliance software interface]

The designs are imported with their original file names and file types at this point. To finish the process, click the ‘Write’ button. Navigate to the desired destination and click ‘Select Diskette.’

When you view the newly created Designer 1 media, you’ll see the files are renamed appropriately and all the necessary support structure is also created.

**Tip:** You are not required to write to an actual diskette. If you create folders ahead of time, you can actually “write the diskette” into a folder on your hard drive for copying onto a diskette later.

Similarly, Designer diskettes and sticks can be read into Embrilliance by clicking the ‘Read’ button.

**Note:** If you want to add files to a previously created Designer diskette or stick, you will need to first read in the designs and then add the new files to one of the menus. When a Designer disk or stick is written, it replaces any matching file and folder names.
Preferences

Removing Overlaps Preference
When creating a composition, you can arrange designs so that they overlap. Embrilliance automatically removes the overlapped stitches using our patented system. When you save your design, the stitches will be automatically removed. If you prefer this not to happen, uncheck the box and click Apply.

Auto Recover
Auto recover will save your file in a separate space every so often. This is adjusted using the slider. This feature is useful when working on a complex arrangement where a power outage or program crash (unlikely) or freeze by the operating system (it happens) could force the program to quit and you might lose your work. If you are working while power-outs are happening, well, turn this on. And don’t run your embroidery machine; brown outs are not good for them.

Checking For Updates
The program can check for updates if it is running on a system connected to the internet. This will occur once each day, the first time that you run the program. The program does not send your information or anything about you or your computer to us. It merely checks the current version available online for your program and if there’s an update, it lets you know. If you don’t want this, you can turn this off.

You can also check for updates at any time from the option in the Help menu.
Creating a simple letter design or monogram is, well, simple! Just click the Create Letters tool found on the Design Toolbar. This action will place the new lettering in the center of the design page and display the Letters Property tab.

**Monograms vs. Letters**

Traditionally, monograms were a single letter—“mono” meaning one and “gram” referring to the letter. Today most monograms are 3-letter combinations with the center letter larger than the outer two.

Fonts or letters styled specifically for such monograms are prefixed with “MGM” to easily distinguish them from more standard fonts. Of course, you can make a monogram with any font style and use the enveloping features to shape the design.

Now, set the monogram to your desired value by typing into the Text box and pressing the ‘Enter’ key.
**Selecting Letter Type**

Although the fonts prefixed with “MGM” are designed for traditional three-letter monograms, you are by no means restricted to three letters. For example, if you just want the large center letter, enter a space and the character you want.

*Type a space before a letter for a large single letter*

For fun, you can use a monogram font with entire words. This method works best with all capital letters and shorter words.

*Sample above uses MGM Rounded applied to a word.*

Overlapping letters is sometimes needed for your design, and when you do that within a lettering object, the stitches that are hidden will be removed automatically:
Embrilliance

Customize the Design

The Letters Property tab provides a number of tools that allow the design to be customized.

There are three basic styles for lettering:

- Multi-Line Text
- Single line of text or Monograms
- Text on a Circle

The lettering design can switch between these styles using the three buttons at the top of the property tab as shown above.

Multi-Line Text is useful when you want to enter an entire saying, poem, etc.

This is multi-line text
The little dog laughed
To see such ...

etc

Single line of text or Monograms is useful for entering a single line of text or a Monogram. With a single line of text there is more flexibility in the shape such as the enveloping feature. With Monograms there are some fun Quick Styles that re-shape the 3-letter monogram and when overlapping the monogram letters the Sewing Order finishes the look.

Circle Text wraps around a circle. If you overflow the amount of letters that can fit on the circle, you will see your text spiral outwards. To see the text on a circle, you will have to adjust the 'Radius' of the circle using the slider.

Spiral text starts in the center.

When writing on a circle, you have the option to put text either on the inside or outside; when embroidering, we usually think of
this as text at the bottom or top of a circular patch or badge. To switch this, use the checkbox labeled “Place on bottom.”

**Monogram Font and Quick Style**

The font and style are changed using the selections in the Font and Quick Style boxes.

![Quick Style menu]

When the lettering is initially placed on the page, the letters are automatically kerned (letter spacing) for a good visual effect. Note that these styles are designed to accomplish traditional monograms, and therefore some only work properly with two or three letters.

**Font Selection**

Some fonts may only have uppercase letters. If you’re using a font and not seeing the desired characters, clicking the ‘?’ button to the right of the Font box; it will display all characters available in the selected font along with size recommendations.

![Characters available shown with recommended size ranges.]

**Slant and Space**

The slant of the monogram and the spacing of the monogram letters are controlled with the Slant and Space slider controls. If you use these controls and want to return the monogram to its default settings, simply click the zero control. This will restore the default setting. The Slant gives an italic effect to the monogram.
Embrilliance

Enveloping
The envelope (containing top and bottom outlines) of the lettering (single or multi-line) can be individually customized. The Envelope Type box and Envelope Slider control the envelope. There is an Envelope Slider control for the envelope top and there is an envelope slider control for the envelope bottom. There are four styles of envelope: Curve, Grow, Peak and Shrink.
If you use these controls and want to return the lettering to its default settings simply click the zero control.

Enveloping can produce a variety of creative designs, especially when you begin breaking up the words into segments and enveloping each one separately.

Sample above uses two envelopes and a lower case “o” resized for bubbles.

Changing the Color of one Letter
You can change the color of one letter by selecting that one letter. To select it, first make sure the lettering object or monogram is selected, then click on the green handle that appears centered over the letter you want to change. Once a single letter is selected, you can change the color(s) of just that one letter using the color property page as described previously.
For more information on threads and colors, see the section on Color.

Monogram Sewing Order
On the Letters tab there is a Sewing Order box. Choose the order in which the letters are sewn from this control. For a simple monogram you probably do not want to change the default order. However, if you want to overlap the center letter on the others, you could choose the ‘ACB’ order (second choice).
**Stitch Properties**

The Stitch tab contains controls for the actual stitch generation of the Lettering.

Note: This tab will not be displayed for imported fonts, as those designs are different in nature.

![Stitch Tab Controls](image)

**Satin Density Control:** This control ranges from 3 to 20 with each tick being one tenth of a millimeter. So the range in millimeters is .3 to 2.0 mm. The smaller the density number the closer together the satin stitches will be. 0.4mm is normal.

**Compensation:** This control ranges from 0 to 10 with each tick being .1 millimeter. As the value increases the stitch length increases, in effect ‘fattening’ the stitching. This is useful on fabrics that have a loft or nap, and can also be used to make a font appear bolder.

**Remove Hidden Stitches:** When selected, stitches that are completely hidden by top stitches will be removed. This process allows the design to sew out in a flatter manner. Note that this only affects stitching within the monogram itself.

**Edge Run:** When checked, this adds a running stitch underlay. This setting is the amount of inset for the edge run and ranges from .1 to 1.2 mm.

**Satin:** When checked, this adds a satin underlay. When checked, it applies the density value, which ranges from .3 to 2.0 mm just like the satin stitch.

The Set Defaults button restores each of these controls to their default values.
You can manipulate the text to form a shape or path. Each letter has several handles to accomplish this. Click on a letter’s center green handle to select that letter.

The center handle will move that letter.

The green pennant handle on top of the center will stagger the letters from that one forward:

The blue handle at the center will rotate the letter and all subsequent letters. And the green pennant under the center handle will move that letter and all the letters on the line following it.

Using these handles, you can make your letters into virtually any shape.
**Monogram Placement**

**A Closer Look:** You can manipulate text to fit virtually any kind of path using the handles for the text design as well as the individual letter and rest-of-line handles. The letters have additional control handles which display when the monogram is selected:

- **Letter Size and Rotation:** As with any design, the letter itself has four black handles for resizing, and a blue handle at the top, right used to rotate the letter on its own.

- **End-of-Line Handles:** Note the Center Green Handle in each letter. This handle that appears in the center of a letter when the lettering design is selected and it is used to move the individual letter. Simply click on it and drag the letter to the desired position.

  Clicking the center green handle also allows you to change the color of that letter only, leaving the others untouched. Use the Colors page in the Property Sheet to change the letter color, as you would change any color layer in a design.

  Clicking on the green center handle will display three additional handles. These handles give a wide range of control over the positioning of the letters. The handles work on the selected letter and all letters to the right of the selected letter. Let’s take a closer look at these handles:

- **Top Green Handle:** The handle over the center handle is a line stagger. This handle staggering the letters vertically and changes the spacing simultaneously. The example shows a stagger upward.

- **Bottom Green Handle:** This handle is the kerning handle and can be used to move letters from the one selected to the end of a line.

  This handle moves the letters to a new location without affecting the spacing on anything from the selected letter forward to the end of the line.

- **Center Blue Circle Handle:**

  This handle is another tool that moves all text until end-of-line. This handle rotates the letters around the center of the selected letter.
### Towels

**General Instructions:** The placement goes on the opposite side of the fabric and at the opposite end from the label. This allows a traditional triple fold to display the monogram. Folding the towel as you would display it helps visualizing and marking the correct placement.

- **Bath Towel:** The bottom of the monogram should be 4” above the hem or 1” to 2” above the dobbay border, if present. The monogram should be 4” tall.
- **Beach Towel:** The bottom of the monogram should be 5” above the hem or 2” to 3” above the dobbay border, if present. The monogram should be 5” tall.
- **Golf Towel:** The monogram should be centered horizontally with the top of the monogram .5” below the grommet. The monogram should be 1” to 2” tall.
- **Hand Towel:** The bottom of the monogram should be 2” above the hem or 1” to 1.5” above the dobbay border, if present. The monogram should be 3” tall.
- **Sports Towel:** The bottom of the monogram should be 1.5” above the hem. The monogram should be 1.5” tall, and may be placed on a 45-degree angle.
- **Wash Cloth:** The bottom of the monogram should be 1.5” above the hem or 1” above the dobbay border, if present. The monogram should be 1.5” tall and may be placed on a 45-degree angle.

### Bedding

**General Instructions:** Don’t annoy your sleeper. Placement and thread can affect the comfort of the item. Spread out the item as you would see it on a well-made bed to help with visualizing and marking the correct placement.

- **Top Sheet:** Top Sheets are placed on a bed upside-down and the top (wide hem) is then folded back to right-side-up. This means that the monogram is apparently embroidered upside down. Looking at a made-up bed will help you visualize this. Place the bottom of the monogram 2” from the wide hem, centered. The monogram should be 3” to 4” tall. Embroidering inside the wide hem is sometimes preferred, and when doing so the design is sized to fit.
- **Pillowcase:** Embroidering inside the wide hem is generally preferred, and when doing so the design is sized to fit. If the font allows it, the monogram should be 2.5” to 3” tall. Placement is centered, monogram facing toward the opening.
- **Pillow Sham:** Center the design on the sham, facing the long edge as if it were a pillowcase with an opening. The monogram should be 2.5” to 4” tall.
- **Blanket:** Centered on the top like a sheet or facing into the bottom, right corner at a 45-degree angle. The monogram should be 4” tall.
- **Duvet Cover:** Centered on the top. The monogram should be large, up to 12” tall.

### Home Decor

**General Instructions:** None. This is all according to taste, fashion and style.

- **Napkin:** Embroider 2” in from point of corner. Distance may need to be increased if there’s a border or hem. Place opposite of label or tag. The monogram should be 1” to 2” tall.
- **Placemat:** Top-right corner, 3” diagonally from point of corner. The monogram should be 1” to 2” tall.
- **Table Runner:** Embroider matching designs 4” from end. The monogram should be 4” to 5” tall.
- **Table Cloth:** Embroider 4” from corner, with design facing into corner at a 45-degree angle. The monogram should be 4” to 6” tall.
Monogram Placement

**Garments**

**Coat Lining:** Embroider on the right side at the waist level, 3” from the seam. Monograms should be 1” to 1.25” tall.

**Collar:** Embroider on the left side, above buttonhole if present. Monograms should be 3/8” tall.

**Golf/Polo Shirt:** 7.5” to 9” below the shoulders left seam and 4” to 6” from center. Depending on the design, you can also look for a line down from where the collar meets the shoulder seam, and look over from the 2nd buttonhole.

**Long Sleeve Shirt:** Top and center of wrist, which is about 1” to 1.25” from the center toward the buttonhole. The bottom of the monogram should sit very near the top stitching of the cuff. Monograms should be 3/8” tall.

**Robe:** Draw a line straight down from the shoulder seam 4” to 6” for women and 7” to 10” for men. Find the center of the armholes from the armpit to the shoulder, and draw line straight across toward the center of the robe or go across 3” to 5” from the center.

**Shirt Placket:** Center the design between 2nd and 3rd buttonholes. The design should be 1/4” to 3/8” inch tall.

**Shirt with no pocket:** Draw a line straight down from where the shoulder seam meets the collar seam. Find the center of the armholes from the armpit to the shoulder, and draw line straight across toward the center of the shirt. The center of the design is marked where the lines intersect. If the armholes are deep, the line can be made too low on a woman’s shirt, so keep that in mind.

**Shirt with pocket:** Center the design on the pocket hem, with the top of the design 1/4” below the top of the pocket. Monograms should be 1/4 to 3/8” tall. If pocket has button in center, shift design to the right.

**Shorts Leg:** Halfway between center-front and side seam. The bottom of the design should be 1/4” to 1/2” above the hem stitching at the leg hole.

**Short Sleeve Shirt:** Center design 1/4” to 1/2” above the hem on the sleeve. Monograms should be 1/4” to 3/8” tall.
Clicking the Library tool found on the Design Toolbar will display the selection dialog. The dialog has a scrolling list on the left that shows the collections. Select a collection from the list on the left and designs in that category display in the selection area on the right. Select a design and click OK. The design will be placed in the center of the Design Page.

**Frame/Design Thread Brand and Color:**
The thread brand and color are changed just as described in Color section.
The Stitch Simulator lets you see how the design will sew out by sewing on the screen. It is activated by clicking the Stitch Simulator tool in the View tool bar or selecting Stitch Simulator from the View menu.

**Stitch Simulator controls**

The controls are easy to use and give complete control of the simulated sewing process.

**Player Control:** This control lets you sew forward, backward and stop. The right arrow starts sewing forward. The double bars stop sewing. The left arrow starts sewing backward.

**Step Stitch Control:** This control lets you sew one stitch at a time forward or backward. Right arrow: forward. Left arrow: backward.

**Speed Control:** Use the slider to change the speed of sewing. Move to the left for slower to the right for faster.

**Manual Control:** Click and drag this slider forward or backward to quickly move a particular section of the design.

**Stop Control:** Click the Stop button to insert a color stop in the design. This allows you to change colors on the fly. Or creatively use this to isolate parts of the design that you want to remove or isolate.
Individually selected designs can have a basting stitch added automatically. This is useful when you want to add a layer of stabilizer or some other material before the sewing of a design. The baste is always placed intelligently so that it runs immediately before the selected element(s), as shown in the screen shots below.

All elements were selected (Ctrl-A) before applying baste.

Various elements selected individually and together before applying baste.
Notice where the baste stitches are placed in the Objects View.
Basting stitches can also be used to secure a layer of topping stabilizer in place before any designs are sewn. A typical use of this is to add a layer of water-soluble topping to a towel, which keeps the stitches from becoming embedded in the terry cloth loops during sewing. It can be hard to hoop a towel, and the topping stabilizer will want to slide around before the stitching happens, so basting it first can make the process easier.

The basting stitches are added to the start of the design or file, and are added as a separate color; naturally you can use any color you want to sew the baste.

**Tip:** The baste is an Embrilliance object and is therefore scalable.
PRINTING

A design template showing the design at full size and with registration marks can be printed. Just choose print from the File menu.

The template can be previewed before sending the output to the printer. Below is a sample template with a monogram surrounded by a frame. Note the registration marks.

The second page of the worksheet displays size, stitch and color counts, and a list of the colors used in the design with approximate thread requirements.

Printing preferences, found in the Program Preferences window.
HELP

Getting help for Embrilliance products is just a few clicks away!

http://www.Embrilliance.com